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Introduction to Client Manager 
 

This Module is the central database of the Keytime Accountants Suite and stores all 

common information shared between the Suite modules. 

On a practical basis, you will set up clients in Client Manager and decide what types of 

work you wish to undertake for them (tax, final accounts, payroll, etc). You will also be 

able to launch the various modules of the Keytime Accountants Suite from here and 

perform company secretarial duties via the integration with CompanyView (see details 

later in this manual for more information). 

On a technical level, Client Manager ensures that relevant data is made available across 

the whole suite – for instance, relevant data from Accounts Production is available in 

Tax, Corporation Tax, or relevant data from Tax is available in P11D Calculator. 

Client Manager will also be the point where you licence your software and set up your 

users if you opt for a multi-user system. 

Before starting Client Manager, please read the Getting Started section of this manual. 

Configuring Client Manager 
 

It is important to review and setup the configuration options as the system will retrieve 

clients from each of the modules and create them in Client Manager, it is beneficial, 

therefore, to have the system apply as many settings as possible at this stage to avoid 

having to apply each setting manually at a later date.  In order to configure the system, 

you will need to login with the Administrator password, initially this is left blank, please 

see the maintain users section below for further instructions on applying passwords. 

 

We will address each of the Administrator configuration options: 

 

Register your Software 

 

Keytime modules can be registered within Client Manager or in the modules themselves.  

Click the File menu, select Register, select Internet, enter your registration user name 

(this can be found on your registration letter), click Register; the system will bring all the 
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modules you have purchased, tick Activate against all the modules you want to register; 

this will activate your registration. 

 

Manage Software Updates 

 

Software updates are issued from time to time.  These updates may include 
enhancements to existing feature, new features and/or fixes to reported defects.  
Release notes containing information about the content of the update are posted in the 
Releases forum on our support site.  You can subscribe to this forum and receive email 
notification each time release notes are posted: 
http://support.keytime.co.uk/forums/177790-release-notes  

Updates are placed on our website and each module will inform you of availability when 
launched each day (you are only informed once per day, regardless of the number of 
times you open and close the software).  You can manage the download and installation 
of these updates from Client Manager as follows.  Please note - this option is available 
only to the Administrator login. 

Click the Help menu on the main menu bar, select Manage updates.  The options are: 

• Prompt, download and install – This option will inform you of availability and 

give you the option to download and install it; you won’t be able to access the 

software whilst this is taking place should you accept. 

• Prompt and download only – This option will inform you of availability and 

prompt you to download the update, but it won’t be installed.  You would then 

manually run the update in your own time. 

• Manage my own updates – This option will not automatically inform you of 

availability; you will need to manually check for and download the update (by 

clicking the Check for updates button) and install it at a convenient time.  You 

may wish to consider subscribing to the Releases forum to receive email 

notification of update availability 

http://support.keytime.co.uk/forums/177790-release-notes  Release 

notes are also posted in this forum. 

 

Updates are downloaded to the same location as the Client Manager database: 

• If you select option prompt, download and install and you are working in a 

networked environment, the Client Manager database will be available to all 

networked users.  The first user to access the software when an update becomes 

available will be informed of availability and prompted to download and install.  If 

the prompt is accepted the update will be downloaded to the Client Manager 

database location and installed on the user’s PC. 

http://support.keytime.co.uk/forums/177790-release-notes
http://support.keytime.co.uk/forums/177790-release-notes
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Subsequent users accessing the software will receive a message that an update 

has been downloaded and a prompt to install it.  This message will appear each 

time the software is launched until the update is installed. 

• If you select option prompt and download only the update will be downloaded 

into the Client Manager database location.  If you don’t run the update that day, 

the software will prompt you the day after (on launch) that an update has been 

downloaded and it is available in: [path for Client Manager database]. 

• If you select option Manage my own updates the software will not inform you 

of available updates; click the Check for updates button, if an update is available 

you will be given the option to download it.  The update will be downloaded into 

the same location as a Client Manager database.   

 

Maintain Staff Grades and Charge-out Rates 

 

Introduction 

You can set up staff grades, each containing up to 10 charge-out rates; you then apply a 
grade to a member of staff and a charge-out rate to a job.  This gives you the flexibility 
to maintain different charge-out rates for different types of work whilst simultaneously 
maintaining rates across staff grades if required.  

This is how Client Manager obtains charge-out rates in timesheet entries: 

1. Client Manager checks the client record to see if there is a fixed price for the job, 
if there is this is used and no further checks are made.  Fixed prices can come 
from the job (Tools / Jobs and workflow); if there is a fixed price assigned to a 
job, the price will be applied as the job is added to the client record.  The fixed 
price can be removed or edited on the client record. 

2. If there is no fixed price for the job, Client Manager gets the rate code for the 
job; this is obtained from Tools / Jobs and workflow. 

3. Client Manager then looks at the grade assigned to the staff member in the 
timesheet row and gets the rate from the user’s grade; this comes from Tools / 
Maintain staff grades and rates.   

4. Client Manager calculates the number of chargeable units (set up in the staff 
record) based on the time entered on the timesheet row and multiplies the rate 
by the number of units (the number of units is rounded up where the result of 
time entered produces a fraction). 

5. To maintain the same rate for a particular job it is important, therefore, to 
maintain a consistent rate across grades and to specify the same chargeable unit 
across staff records. 
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Setup Staff Grades and Rates 

Setting up staff grades and rates requires Administrator permission, please ensure you 
log into Client Manager using the Administrator user and password.  Proceed as follows: 

• Click the Tools menu, select Maintain grades and rates. 
• To add a grade click the Add button. 
• Enter a description for the grade and enter a maximum of 10 rates.  A rate is 

charged per chargeable unit. 
• Click Save.  The rates are displayed in the main screen as you click through each 

grade: 
 

 
 

• To apply a grade to a staff record click Tools, select Maintain users, click the staff 
record and click Edit, select the grade from the drop down list in the Grade field: 
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• To apply a rate to a job, click Tools, select Jobs and workflow, select the job from 
the drop down list in the job field, apply the rate from the drop down list in the 
rate field: 
 

 
 

Rate Changes 

It may be necessary from time to time to increment or edit charge-out rates.  Client 
Manager maintains a history of rate changes and can apply rate changes at a set point.   

When you first setup grades and charge-out rates client Manager will apply the rates 
regardless of the date you enter on a timesheet row.  This allows you to take on 
outstanding WIP if you are transferring from another system without having to specify 
the earliest date the rate applied.   

Once rates are in use they cannot be changed; if you want to specify new rates you 
‘overlay’ a grade with a new set of rates and specify the date they are to apply from.  It 
is important to note that Client Manager will not recalculate timesheet entries already 
present that fall on or beyond the date for a new rate.  To apply a new rate to any 
existing timesheet entries you must edit the timesheet row, this will prompt Client 
Manager to recalculate the entry.  To specify new rates proceed as follows: 

• Log into Client Manager using the administrator user and password.  Ensure other 
users are not attempting to process timesheet entries. 

• Click Tools, select Maintain staff grades and rates, select (click) the grade you 
want to apply new rates to and click the Edit grade button. 

• Click the Apply new rate table button: 
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• Select a date that the new rates are to apply from and if you want to copy the 
exiting rates to the new table click Yes, otherwise click No.  The new rate table is 
then created. 

• Enter the new rates: 
 

 
 

• Click Save. 
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Maintain Users/Staff and Passwords 

 

You can setup staff members, apply grades and specify working hours and chargeable 

time units, you can also add passwords.  Users are also assigned to security groups, 

which can allow/prevent access to certain options and also prevent the submission of 

returns and accounts in the modules.  See section Creating and Maintaining User 

Security Groups for further instructions. 

To create user profiles proceed as follows:  

 

• Log into Client Manager using the administrator user and password. 

• Click the Tools menu, select Maintain users, click Add. 

• Enter the user name and a code (usually their initials). 

• Specify the user’s charge-out rate(s) by selecting a grade (see earlier section for 

details of staff grades and rates) 

• Define a chargeable unit by entering the number or hours or minutes in a unit 

and then select hours or minutes.   

• Entries in the Signature and Job title fields can be used to add to mail merge 

documents.  Click Save. 

• Click the Hours worked tab and enter working hours (as hours and minutes) for 

each day.  The system will use this information to calculate how much time needs 

to be accounted for in timesheets. 

• Click the Restrictions tab.  You can specify whether other users on the system can 

see, and therefore access, client assigned to this user.  By default, when you 

create a new user other users will be able to see clients assigned to them and 

vice versa.  To prevent users seeing this user’s client, click the user name in the 

column to the right ‘These can see this user’s clients’ and click the arrow pointing 

left to move them over to the column ‘These can’t see this user’s clients’.  You 

can make individual client records private, for further instructions on how to do 

this see section Lock/unlock a private client. 

• Click Save and Close when complete. 

 

To add a password, click the user in the user list, click the Password button and enter 

the existing password (if any), enter the new password and enter it again in the 

confirmation box.  Users can their change password at any time whilst they are logged 

on to the system by clicking the File menu, select Change password. When you first start 

with Client Manager, you will find an Administrator profile that has access to all clients, 

settings, options and all areas of functionality.  This user profile cannot be removed it is 



11 | P a g e  
 

 
0845 456 3103 support.keytime.co.uk 

advisable, therefore, to add a password to this profile to prevent unauthorised use of the 

system.   

 

Creating and Applying User Security Groups 

 

In addition to the access rights assigned in the Maintain Users screen, you can create 

and assign rights to security groups; you then add users to groups.  You can prevent 

users from accessing system settings, viewing financial information, viewing certain 

reports and accessing the billing routine.  Note: It isn’t necessary to create user security 

groups; they are used to further refine basic user rights.  To create security groups 

proceed as follows: 

• Logon as Administrator, click the Tools menu, select Security, select Groups. 

• Click New and enter a group name, e.g. Staff: 

 

 
 

• Click Data, options presented are View financial information – if you do not tick 

this option users in this group will not see any figures in the Time & fees tab in 

the client record, figures as calculated in timesheets and will not be able to access 

any of the WIP or billing reports.  Other options are to allow the group to 

create/delete tasks in client records, assign groups and access the billing routine. 

• Click Reports.  If you do not allow the group access to financial information, they 

will not be able to access any of the WIP or billing reports.  Click through the 

report options and allow access to the reports you want this group to view. 
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• Click Menu.  Here you can allow/disallow access to certain menu options.  Click 

through the menu options and allow access to the areas you want this group to 

access. 

• Click Modules.  You can prevent on-line submissions to HMRC and Companies 

House by ticking the option Disable Submissions.   

• Once you have finished click Save and Close. 

• Click the Tools menu, select Security, select Users: 

 
• Select a user from the drop down list in the User field, all security groups will be 

visible in the All Available Groups frame. 

• Select the security group you want this user to belong to and click the arrow 

pointing left; this adds the user to the Group Assigned frame on the left. 

• Click Save, choose the next user from the drop down list and repeat as above.  

 

Maintain Jobs and Workflow 

 

Client Manager installs with a number of pre-defined jobs; these work in conjunction 

with the various modules and cannot be removed.  In addition to the services offered in 

the various compliance modules, you can create other services offered by your practice, 

for example, you may offer consultancy services, completion of VAT returns, monthly 

management accounts etc.  These services can then be applied to your client records as 

jobs and utilised in the mail merge and deadlines functions.   

 

To create additional jobs, click the Tools menu, select Jobs & workflow, click the New Job 

button, click the Add new job button in the Jobs listing, enter a description and select the 

entity type that this job may apply to.  If you want workflow to begin from the year end 

date for this job tick the Period Year End option. 
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Assign Charge-out Rates or Fixed Prices to Jobs 

Client Manager will automatically calculate a price or charge-out rate on timesheet 

entries.  It obtains the correct price or rate by first checking the job in the client record 

for a fixed price; if it finds one it uses that.  If there is no fixed price the system then 

checks the rate on the job, it then checks the staff grade and gets the appropriate rate 

for that grade. 

 

To assign a default fixed price to a job, first select the job for the drop down list, then 

tick the Fixed Cost box; enter the fixed price.  When the job is added to a client record 

the fixed price will be added too; the price can be edited at client level. 

 

To assign a rate to a job, click the drop down in the Rate box and select the rate, click 

Save.  If you want to maintain a consistent rate for a particular type of work you need to 

ensure that the same rate is consistent across grades. 

 

Once you have created your jobs, you can add workflow (job stages) and assign 

members of staff that would generally fulfill them.  This works in conjunction with the 

deadlines function; you can assign staff at job stage level and also at client level. 

 

To create job stages proceed as follows: 

 

• Select the job from the Job drop down list, click the Add button below the 

workflow grid and enter the date the stage is due, alternatively, you can leave 

the date field blank and enter a number of days in the Days field; job stages are 

linked together by the system in the order which you specify in the grid, the 

system will calculate the due date for the job stage as the number of days from 

the due date of the previous job stage.  For example, if the first job stage for an 

SA100 job starts on 6th April and you enter 20 in the Days field of the next job 

stage, the system will calculate that the next job stage is due on the 26th April 

(20 days from the last job stage).   

• Workflow for Accounts Production (AP) and Corporation Tax jobs (CT) starts from 

the year end date; you will be prompted for the year as you add the job to the 

client.   

• Enter a description for the job stage and assign a member of staff; this can be 

changed at client level.  The Type will always be Job Stage and cannot be 

changed. 
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• You can add and delete job stages by clicking the Add or Delete buttons.  You can 

move their positioning by clicking the job stage to move and click either the Up or 

Down button.  Click Save to save your changes and Close to exit the screen.  

 

Manage Document Categories and Mail Merge Templates 

 

Client Manager features a mail merge function; you can merge data from Client Manager 

into Microsoft Word documents and save the document as a communication record on 

the client file.  Mail merge documents are saved as normal .doc(x) files in a MailMerge 

Templates folder in your Client Manager database location.  If you have a single user 

stand-alone copy of Keytime Software this will be on your PC hard drive (assuming you 

haven’t changed the location on installation) in: 

C:\Users\[username]\AppData\Roaming\Keytime Data\CM+ If you have a networked 

version, the folder will be in the same location on your network as the Client Manager 

database. 

You can utilize Word documents that are stored in other locations either on your hard 

drive or on your network; as you add the document using Template Management in 

Client Manager, the document will be copied into the MailMerge Templates folder, this 

ensures that your mail merge documents are consistently stored in one place and that 

they are backed up if you choose to use the Client Manager backup utility. 

Create Document Categories 

You can create document categories and add existing documents to these categories, or 

create new documents, click the Tools menu, Communication settings \ Document 

templates.  To create a new document category click ‘category’ in the list of folders and 

click New, enter the category name and click OK; this will create a sub-folder in the 

MailMerge Templates folder.  To rename a category, double click it in the category list 

and overtype the name.  To delete a category (and the contents of the folder), click the 

category and click Del.  Note that if there are documents in the category folder these will 

also be deleted.  

Create and Manage Mail Merge Documents 

You can create a new document template or add in and utilize existing Word documents.  

To utilize and existing Word document, click the document category you want this 

document to relate to, click the Add button (by Templates), you will be prompted for the 
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location of and existing Word document, browse to the document location and click 

Open; this will copy the document and place it in the category folder. 

To edit the document, add database fields etc. click the document in document category 

and click Edit, this will open the document in Microsoft Word.  To add mail merge fields 

from Client Manager, place the cursor at the position for the first field and right click; a 

menu will appear, select Client Manager, select an option from the sub menu, click to 

select the required database field.  Continue with this process until you have all the 

required database fields; note that you must place the cursor wherever the database 

field is required to appear in your document, for example if you require 4 address fields 

and they are to appear one under the other select position the cursor for the first field, 

select the field and press enter then select the second field, and so on. 

Once you have finished editing the document click Save.  You must save the document 

in its original document category location; if you click Save as and save the document 

elsewhere your changes will not be reflected when you run a mail merge in Client 

Manager. 

To start a new document and add it as a mail merge template to Client Manager, select 

the document category and click New (by Templates), enter a name for the document 

(without the .doc(x) extension; this will be added automatically), Client Manager will 

open a new document with this name.  Create your document as required, following the 

instructions above to add mail merge fields as required, once you have finished click 

Save.  You must save the document in its original document category location; if you 

click save as and save the document elsewhere your changes will not be reflected when 

you run a mail merge in Client Manager. 

To edit an existing mail merge document, select the document category and click the 

document and click Edit.  Ensure you save the document back to its original location. 

To delete a mail merge document, select the document category and click the document, 

click Del.  Note that this will delete the document from the document category folder as 

well as removing it from the list of documents in Client Manager. 

 

Communication Settings 

 

You can create commonly used subjects and subject types for use in communication 

memos; subject and types can also be typed directly on to the memo if preferred.  You 

can also create your own communication status e.g. Call back, follow up required etc.  
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To create communication status, common subjects and subject types, click the Tools 

menu, select Communication settings and select the required option on the sub menu.  

To add an item click the Add button, to delete an item click the item in the list and click 

Delete, to edit an item click the item in the list and click Edit. 

 

Create Distribution Groups 

 

Distribution groups are groups that may be allocated to client records; you then use the 

groups to send correspondence to clients, the distribution group could be something as 

simple as a Christmas card list.  To add a group, click the Tools menu, select Distribution 

groups, select Create distribution groups, click the Add button and enter a name for the 

group.  To edit a group name, click the Edit button.  You can sort the list in alphabetical 

order, ascending or descending. 

 

Distribution groups are assigned to clients but can also be associated with jobs or 

services offered to the client.  For example, if you offer the completion of SA100 tax 

returns, SA100 will exist as a job, you can then assign a distribution group to the job, 

this may be a standard letter you send to all SA100 clients, when you apply the SA100 

job to a client the distribution group will also be applied. 

 

To assign distribution groups to jobs, click the Tools menu, select Distribution groups, 

and click Assign distribution groups to jobs.  Select the job from the drop down list of 

jobs; tick the distribution group(s) to be applied with this job from the list of distribution 

groups in the list below. 

 

Integrating Keytime Modules 

 

Client Manager can distribute data to and retrieve from the various Keytime compliance 

modules.  You can decide which modules you wish to distribute data to and retrieve from 

by selecting the various modules to integrate.  Any that you choose not to integrate will 

operate as stand-alone modules and will not update or be updated by changes made in 

Client Manager.     

 

To enable/disable integration between the various Keytime modules and Client Manager 

click the Tools menu, select System Integration: 
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Click the modules you want to integrate with Client Manager, click Save.  If you have 

created client records in the various modules but haven’t been using Client Manager up 

to now you can import the client records from the modules, click Import Clients. 

Changes are retrieved from and distributed out to individual records in the various 

Keytime modules.  If you are already using the Keytime Accountants’ Suite, the system 

can read all the individual records in all the modules and create your client records.  

Client Manager will create client records with an appropriate entity type; this is based on 

the module the record is taken from:  An SA100 from tax will be created as an individual 

in Client Manager, an SA800 will be created as a partnership, a CT600 will be created as 

a limited company and so on.  

 

Client Manager will attempt to match client records across modules by comparing a 

series of unique identifiers, records will be compared on the following basis: 

 

• By UTR – individuals, trusts, and partnerships are identified on this basis, where 

the system finds records with duplicate UTR’s within the same module duplicate 

records will be created in Client Manager.  Where the system finds the same UTR 

but across different modules one record will be created in Client Manager with 

links to associated records in the modules.  

• NI number – where the UTR is not present, the system will look for the NI 

number and compare on that.  Where the NI number is not present/relevant the 

system will look at the name of the return. 

• Limited companies from Accounts Production and Corporation Tax are identified 

by name, tax reference and company registration number. 

 



18 | P a g e  
 

 
0845 456 3103 support.keytime.co.uk 

You may find that in some cases, Client Manager has created a duplicate record, maybe 

where the unique identifiers are missing, in this case you can archive the client record in 

Client Manager in order to remove it from your client list (see Archiving Client Records 

for further details). 

 

If this is the first time you have used the Keytime Accountants’ Suite and you don’t yet 

have any records in any of the modules, you can create your client records in Client 

Manager and make them available for use in the modules (see section Creating Client 

Records for further details on how to do this). 

 

As you work in the individual modules, any changes made to standing client data will 

automatically be updated in Client Manager.  If you make a change to client standing 

data in Client Manager, your changes are reflected in the client record in the individual 

module(s).  For example, if you change the address of a limited company in a tax return 

in Corporation Tax, your change will also be recorded on the client record in Client 

Manager.   

 

It is important to note that changes made in Client Manager only affect the record for 

the latest year, for example where a tax return for the year 2011/2012 is the latest year 

(there is no 2012/13 return), Client Manager will only work with that record.  This is to 

prevent completed and filed returns or accounts from previous years from being 

updated. However, if you make a change in the previous year tax return, the change will 

reflect in Client Manager and, therefore, the current year return. 

 

As you perform year end on returns or accounts in the modules, Client Manager 

effectively drops the integration with header detail in that record and connects with the 

newly created record in the latest year.  New jobs and job stages are added each time 

you year-end a record in one of the modules. 

 

One notable exception to the two way integration is the P11D module; if you add a P11D 

job to a client record in Client Manager, the return will not be created in P11D, instead 

you must create the return in P11D first and when you next load Client Manager, the 

company and employees will appear as client records. 
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Unique Identifier and the Client ID 

 

Each record in any of the modules may have a Client ID that you manually enter, or 

Client Manager can automatically generate.  You are free to maintain this client ID as 

you wish without any detrimental effect on the integration with Client Manager.  As client 

records are created in Client Manager, or brought in from the modules they are 

automatically assigned a unique identifier, this identifier is a unique internal reference 

which identifies the client to the system for as long as the client exists.  This is 

particularly important when backing up and restoring data, for example, if you have 2 

PC’s with a copy of Tax on each and they do not share a common database (so not 

networked), if you create tax returns for the same client on both PCs the records will be 

created with a unique identifier which will differ on each PC.  If you backup the return 

from one of the PCs and restore it onto the other you will get a duplicate record, both in 

Tax and in Client Manager. 

 

If you create the tax return on just one of the PC’s, back it up and restore it onto the 

other PC, the return will be restored with the original unique identifier, you can then 

work on the return, back it up and restore it back onto the original PC and the original 

return will be overwritten with your changes; you won’t encounter a duplicate record as 

the return will have retained its unique identifier which identifies it to the system as 

being already in use. 

 

Partnership SA800 returns with the partners SA100 returns linked to them will always 

retain their original linking as the SA100 will always have the same unique identifier.  If 

you were to backup an SA100 that is linked to an SA800, restore it to a different PC, 

work on it and then back it up and restore it onto the original PC the SA100 will be 

overwritten with your changes and the link between the SA100 and SA800 will be 

retained.   

 

The unique identifier is also retained at year end, so as the tax returns are created for 

the new tax year, the old returns are assigned an internal archive reference and the new 

returns given the existing unique identifier.  This means that SA800 partnership returns 

retain their links to the SA100 partner returns.   
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Working in Client Manager 
 

Navigating Client Manager 

 

When you first launch Client Manager you first be asked to select a user name and enter 

a password, select your user name and enter your password, any user names that are 

currently in use show with a red circle, user names available for use show with a green 

circle.  If you haven’t yet created users and passwords select Administrator and click 

Logon. 

 

If you already have client records in the modules these will have been imported into 

Client Manager and you will see these in the main Client grid.  If this is the first time you 

have use the Keytime Accountants’ Suite and you don’t yet have any records, the Client 

grid will be empty.  

 

Down the left of the main screen, you will see a navigation pane containing the various 

aspects of Client Manager are divided into three main groups:  Client Manager, Data and 

Programs: 

 

• Client Manager – controls the grid view you see displayed in the main screen.  

Options are Clients – view all clients, Communications – view all 

communications, Tasks – view all outstanding tasks and job stages, and 

Timesheets – enter timesheet detail. 

• Data – Options for working with your client data.  Print contains a series of 

reports, select the type of report and apply criteria.  Reports can be output to 

screen, printer, Word, Excel or PDF.  Letters – create or apply stored letters to a 

range of clients.  Email – create an email and send it to a range of clients.  

Tasks – create a task and apply it to a range of clients.  Groups – work on 

groups of client records.  Timesheet Billing – Draws items from timesheets that 

have been passed for billing. 

• Programs – Launch any of the Keytime modules.  In addition you can create a 

link to another well used application and launch that from the menu too. 

 

In addition to the navigation pane, there is a main menu bar across the top left of the 

main screen.  Options are: 
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• File – create client, change password, backup, restore, repair database, logoff, 

register and exit. 

• Edit – cut, copy and paste details. 

• Information – Practice details including login credentials for CompanyView (see 

later section) and letters. 

• Tools – Clients, communications and Tasks grid views, options, client ID settings, 

linking, templates, notes, maintain users, security and settings. 

• Help – contains the Client Manager help file, licence agreement and system 

details. 

 

Creating Client Records 

 

Client records can be created in Client 

Manager and made available in the various 

modules.  To create a client in Client 

Manager, proceed as follows: 

 

Click the Add new client button on the top 

left of the navigation pane and select the 

client type.  
 

The following screen is presented: 



22 | P a g e  
 

 
0845 456 3103 support.keytime.co.uk 

 
 

Fields in the client tab will differ according to client type (the screen above displays an 

individual).  Enter the client name and other relevant details; enter the address details, 

enter the details in the Client tab; this information is transferred to the relevant 

modules.  Click Save; further tabs appear below the main client details, these are 

Communications, where all communications for this client can be viewed.  Tasks 

displays all tasks for this client.  Associated links where you can link client records 

together and view their relationships.  Jobs where jobs and job stages are displayed, 

Documents where you can view all documents attached to the client record, these may 

be letters or PDF copies of tax returns or accounts. 

 

Click the Practice tab in the main client detail.  The services you offer to clients are 

called jobs within Client Manager, click the Add button just above the jobs frame and 

select the jobs for this client, if you select a job that is linked to a Keytime module 

(SA100, 800, 900, AP or CT) the return will also be created for you; as you launch the 

individual module and open the new return you will be prompted to complete the setup 

by entering further information.  

 

Workflow that is associated with this job will automatically be added at the same time 

and will be visible in the main Tasks grid and Jobs tab in the client record.  When you 

create a record for an individual and add an SA100 job, you will be prompted for the tax 

year; Client Manager will then link to that individual’s record in the Tax module.  As you 

year end the tax return, Client Manager will drop the live link with that years’ tax return 
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and link to the next years’ return.  This prevents the client details being changed in a 

return that has already been filed. 

 

One notable exception to the two way integration is the P11D module; if you add a P11D 

job to a client record in Client Manager, the return will not be created in P11D, instead 

you must create the return in P11D first and when you next load Client Manager, the 

company and employees will appear as client records.  

 

If you have associated distribution groups with jobs you have added to the client record 

these will also be added to the client record.  You can add further groups by clicking the 

Add button above the Distribution Group frame and selecting a group.  You can add a 

new group by clicking Add in the Distribution Group window, enter a description for the 

group and click Save.  Select the group and click Save. 

 

Assign a partner to this record by selecting the partner from the drop down list in the 

Assign to field. 

 

In the Type field, select the record type, options are client, contact or prospect. 

 

In the Status field, select the record status, you can manage (create, edit and delete) 

your own status by clicking the green Add button by the Status field; you can then filter 

and sort your records by status in the main Client grid. 

 

Linked Client Records 

 

You can link client records together, display relationships and move between linked 

records by clicking the various links.  To link client records together: 

• In the client grid, locate one of the client records to be linked, 

• Click the Associated Links tab, right click in the grey area of the screen, select 

Add New Association. 

• You can enter the client code or name and use the up and down scroll bar to 

locate the record you want to link with.  Click the record to begin the link process. 
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• You will notice the two records appear in the bottom section of the screen, choose 

an option from the Relationship is dropdown list for both records.   

• You can create your own relationship types by clicking the Add New Relationship 

button enter a description and click Save  

• You can make any notes on the relationship in the Note section of the Link 

screen. 

• Click Associate to complete the linking process. 

• If you view the Associated Links tab of the client record, you will see details of all 

the linked records.  To open an associated record, double click it in this grid; you 

will be taken to that record.   

• To remove a link, right click the associated record in the grid and click Delete 

Association. 

• If you use CompanyView to add officers or match to existing records the 

associated link will be established for you. 

 

Agent Authorisation (64-8) 

 

Before you can use on-line agent authorisation you must add your agent filing 

credentials and agency references to Client Manager:  Click the Information menu, select 

Practice, enter your user name and password and agency reference for each service.  

Note:  Your user name and password are the same credentials you use for on-line filing 

in the Keytime modules; therefore, you must be registered to file with HMRC before you 

can request agent authorisation for these services. 
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Agent authorisation can be found in each client record, to request or manage agent 

authorisation open the client record from the main Client grid, click the Practice tab in 

the client header and click the 64-8 button.  Note:  Not all services can be authorised 

on-line; Tax credits must be requested on a paper 64-8, VAT must be requested either 

on a paper 64-8 or using HMRC’s VAT for Agents on-line service.  Proceed as follows: 

Request Authorisation On-line 

• To request agent authorisation on-line, first select a service from the On-line tab, 

note that you can select only one service at a time; where you are requesting 

authorisation for multiple services you must send multiple requests. 

• If the client is either an individual, partnership or trust and based overseas click 

the Based Abroad box.  Click the Authorise button. 

• Client Manager will validate and go on to submit the client details.  The following 

items are validated and submitted: 

Unique Tax Reference (UTR) or PAYE employer reference for PAYE 

National insurance number (individuals) 

Postcode (unless based abroad is ticked) 

Your reference for the client (optional, but will be submitted if it is present 

in the client record)  

Your agent filing credentials and agency reference for the service 

• You will be informed as to whether the submission was successful and the 

submission date will be displayed in the box on the Authorise line directly below 

the service. 

 

Activate an Authorisation Request 

When HMRC receive an authorisation request, they will write to your client with an 

authorisation code, which you must obtain from the client and activate within 30 days of 

the date of issue.  Your client should receive this within 7-10 working days of your 

request.  To activate an authorisation: 

• Select the service from the On-line tab in the 64-8 screen and click the Activate 

button.   

• Enter the authorisation code you obtained from the client when prompted; the 

code consists of a 2 letter prefix followed by 8 digits.  Note that the prefix is case 

sensitive and must be entered exactly as HMRC have issued it.  Click OK to active 

the authorisation request. 
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• You will be informed as to whether the submission was successful and the 

submission date will be displayed in the box in the box on the Activate line 

directly below the service. 

Authorisation Code is Lost or Expires 

The authorisation code sent to the client must be activated within 30 days of being 

issued, if the code is lost or 30 days has elapsed and the code has expired a new 

authorisation code must be obtained.  To obtain a new authorisation code: 

• Select the service from the On-line tab in the 64-8 screen and click the Re-

authorise button.   

• On successful submission the original submission date is updated and can be seen 

on the Authorise line directly below the service. 

• HMRC will write to your client with a further authorisation code that you must 

obtain and activate within 30 days (proceed as per Activate an Authorisation 

Request above). 

Removal of Agent Authority 

You can tell HMRC you no longer represent a client using the same agent authorisation 

service.  To remove agent authority: 

• Select the service from the On-line tab in the 64-8 screen and click the De-

authorise button. 

• On successful submission the submission date is displayed in the box on the De-

authorise line directly below the service. 

Check Status 

You can check the status of a submission by first selecting the service and then click the 

Status button, this will tell you where any pending submissions are in the authorisation 

process.  

Paper 64-8 

You will find an option to print a 64-8 in the Print tab of the 64-8 screen.  Client Manager 

will fill in as much information as is present in the client record; fill in the remainder as 

required. 
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Lock/unlock a Private Client 

 

You can lock a private client to a particular user; the client will be visible to everyone 

(name only) within Client Manager, but will only be visible in the modules to the user it 

is assigned to.  In addition, only the system administrator and user it is assigned to can 

see and make changes to the client details.  To make a client private, proceed as 

follows: 

It must be stated at this stage that only the system administrator has the ability to 

lock and unlock private clients.  The administrator can also see the client detail, 

both in Client Manager and in the modules; therefore, it is VERY IMPORTANT 

that the system administrator is assigned a password and that it is kept secure. 

1. Login to Client Manager using the Administrator password. 

2. Locate (or add) the client record, click the Practice tab. 

3. Click the drop down mane in the Assign to field and select the user this client is to 

be locked to. 

4. Click the Lock button (the image will appear unlocked) to the right of the Assign 

to field to lock the client. 

To unlock a private client, follow steps 1 – 4, in step 4 as you click the Lock button (the 

image will appear locked) you will be asked if you want to unlock the record, click Yes. 

When working with private clients, the client will only be available in the modules if the 

user is the assigned to that client; the system picks this up from the login details, either 

from Client Manager if you accessed the module from there or as you login to the 

individual module.    

 

Archive Client Records 

 

Client records cannot be deleted, instead they are archived.  You can retrieve a client 

record from the archive and the system will automatically restore the module links. 

Client records cannot be archived where there is unbilled time in timesheets; you must 

deal with any unbilled time (WIP) by either passing and billing it or writing it off through 

the billing routine.   

To archive a client record, proceed as follows: 
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1. Only the system administrator has access to the client archive and the archive 

routine; logon as Administrator. 

2. Locate and open the client record to be archived in the main Client grid. 

3. Click the Tools menu, select Archived Clients; you will be prompted for the 

Administrator password – enter the password. 

4. There are two tabs on the screen, select Archive and click Test: 

 

 

 

5. In the above screenshot the system has found unbilled time for this client, the 

Archive button, therefore, is disabled until the time has been processed; either 

written off or billed. 

6. The system will also detect links to other modules, the client can be archived if a 

link is present, but it should be noted that the client record in the module will also 

be archived at this point. 

7. Click Archive to archive the record. 

 

Retrieving Clients from the Archive 

 

Client records can be retrieved from the archive; any links to the modules will be fully 

restored.  Proceed as follows: 

1. Logon as Administrator, click the Tools menu, select Archived Clients, enter the 

Administrator password. 

2. There are two tabs in the screen, click the Unarchive tab. 
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3. A list of records that have been archived is presented; you can use the search if 

the list is long. 

4. Select the client you wish to retrieve (tick the Selected box) and click Make 

Active, click Close; the client will reappear in the main Client grid. 

5. Links to the modules (where returns where not deleted) will also be restored as 

active client records. 

 

Maintain Jobs and Job Stages 

 

Adding a job to a client record adds job stages and defaults from the Job template.  If 

you flag a job as fixed price and add a price at job level, those defaults along with the 

job stages and due dates will be copied to the client record.   

 

You can amend any of the defaults at client stage: 

 

• You can amend a fixed price or remove it altogether and specify time based 

billing instead.  

• You can specify a frequency on any job type apart from tax and accounts 

production jobs as these can occur only once per year.  A frequency other than 

once will add further job stages to the existing job (rather than additional jobs). 

• You can amend due dates on the job stages, if you have set a number of days in 

the Days field of the workflow template due dates on subsequent incomplete job 

stages will recalculate. 

• You can specify that job stages start after the year end (see Create Jobs earlier in 

this manual), you will be prompted for a year start and end as you add the job, 

the job stages will then be added beginning the day after the year end date.  If 

you specified in the workflow template a number of days at each job stage, the 

first job stages will be added the day after the year end date plus the number of 

days in the first job stage, subsequent job stage due dates will be calculated on 

the number of days from the previous job stage.  For example, if the year end 

date is 31/12/2010 and you enter 20 days in the first and subsequent job stages 

the first job stage will have a due date of 20/01/2011, the second will be 

09/02/2011 and so on. 

• System jobs (those associated with the other modules in the Suite) will be 

automatically year ended as the job in the module is year ended, for example if 

you run year end in Accounts Production a new job and job stages will 

automatically be added to the client record in Client Manager.  If you remove a 
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job in one of the modules (delete a tax return, or roll back year end in Accounts 

Production), then the job that was automatically created in Client Manager will be 

flagged as inactive, this will be visible in the job header in the client record. 

• Other user defined jobs can also be year ended.  To year end this type of job, 

open the client record in Client Manager and double click the job in the Services 

frame, click the Year End button, enter the next year dates; the next year’s job 

and job stages will be added to the client.  

 

 

CompanyView Company Secretarial   

 

CompanyView is part of a managed company secretarial service from Company 

Registrations On-line.  It gives instant access to up to date details about companies on 

the service.  It also provides a safe, easy to use environment for submitting instructions 

on the preparation of Companies House forms, minutes and registers.  CompanyView 

offers: 

• Full profile reports – key statutory information, compliance dates, directors, 

secretary, share capital, shareholders. 

• History of officer appointments. 

• Online instruction for changes in statutory information, share holdings and 

appointments and resignations. 

• Searchable company list for specific companies or registration numbers. 

• Access companies through a searchable ‘people’ list, view all companies and 

individual is associated with. 

• On-demand document system for the generation of a variety of reports and 

forms that can be downloaded or printed. 

In addition, the service offers the option to submit accounts and annual return on line to 

Companies House and form companies through the on-line Formation service. 

You will need to register for the service to make use of it, but you can view the system 

in demonstration mode through Client Manager at any time. 
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CompanyView Integration with Client Manager 

 

Limited companies, LLP’s and incorporated charities can be integrated with 

CompanyView.  In any of these records you will see options to syncronise the client 

record in Client Manager with the record held in CompanyView, see this company in 

CompanyView, or go to the Formations site, where you can form a new company. 

You can use CompanyView in demonstration mode, when you subscribe to the service 

you will be given a set of user credentials; these need to be stored in Client Manager to 

enable a live link.  Click the Information menu, select Practice Details, enter your user 

name, password and code as they have been supplied to you, click Enable to make the 

system live.   

Syncronise with CompanyView:  You must have a valid company registration number 

before you attempt to syncronise; the company registration number must be entered in 

the Registration no field in the registered office address tab.  From the company record 

click the Get Details button, the following screen is presented: 

 

• Get Details brings information about the company from CompanyView, any 

change in the registered address can be brought into the record within Client 

Manager.  Where there are differences between the two records you will be given 

the opportunity to update the record in Client Manager. 

• The accounting reference date (ARD) is brought from CompanyView and 

compared with the corresponding dates in any corporation tax and/or statutory 
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accounts that are linked to this record, please note that the information is for 

checking purposes only; you will need to change the dates in the accounts and 

tax return to bring them into line.  

• In addition officer details stored in CompanyView can be matched with 

corresponding records or created and matched in Client Manager.  Officer details 

stored in CompanyView are visible in the bottom left of the Officers frame.  To 

match the officer with a corresponding record in Client Manager, click the officer 

name, all records with the same surname will be offered as potential matches, 

click the record on the right of the screen and click Match.  To add the officer to 

Client Manager, click the Add button, this will create the record and link the 

officer to the main company record; visible in the Associated Links tab within 

either record.       

Upload Company to CompanyView:  You can upload existing companies to the 

CompanyView service without having to capture them manually in CompanyView.   

• Click the Update button in the company record, click the Add to CV button.  

Directors do not need to be present at this stage as they can be retrieved and 

linked during the syncronisation process. 

• The company name and registration number are sent to CRO via an instruction 

from Client Manager.  The company details are then retrieved from Companies 

House and made available in CompanyView.  This process takes approx. 24 hours 

complete and in the meantime any attempt to syncronise the record in Client 

Manager with CompanyView will result in an instruction pending message being 

returned.    

• Once the record has been returned from Companies House you may syncronise 

as above. 

View and Maintain Company in CompanyView:  You can see all up to date 

information held on a company at Companies House and submit further instructions.  

Open the company in Client Manager and click the View button in the CompanyView 

frame, if the company exists in the CompanyView system you will be taken straight to 

that record in the Details screen.   

You can only view company details in the Details screen, to make any changes click the 

Instructions button.  Your instructions will be actioned by CRO, who will make the 

changes at Companies House; the changes will then become live in CompanyView. 
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Obtain a view of all companies you have registered on the service by clicking the 

Companies button; you can also click the company name to go directly to the full 

details for that company. 

See all officers by clicking the People button, click the officer name to see details of 

which company the person is an officer or subscriber. 

 

Company Formations 

 

You can form a company and register it at Companies House from the CRO website.  To 

access the formation pages, click Formation in the CompanyView frame in Client 

Manager.  Follow the instructions on the Formations page, the company will be formed at 

Companies House and made available in CompanyView.  You will need to add the new 

company to Client Manager, once the registration number has been added you can 

syncronise the records and bring in the officer records if necessary. 

 

Working in the Client Grid 

 

Click Clients in the Client Manager group on the navigation pane, your clients will be 

displayed in the form of a grid.  You can sort and filter the records in the grid and add or 

remove columns in the view; you can export the grid contents to Excel.  Double click a 

record to open it, or right click and select Open. 

 

Sort and Filter Client Records 

 

You can sort records by clicking on one of the column headers; records are then sorted 

an alphabetical order, ascending or descending.  Use the filters across the grid header to 

filter out records, for example, to see partnership records use the first filter and select 

Partnership.  Use the remaining filters to filter by staff member, job (or service), 

distribution group, record type and status.   

 

Click the Adjust columns button to add or remove columns in the grid, make your 

selection and click Save and Close; the grid will be adjusted to reflect your selection. 
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Right click a record in the Client grid, you will be presented with options to open the 

record, add a communication, add a task or view some brief details on the client. 

 

 

Working with Client Records 
 

Once you have you client records saved, you can begin to store information and 

communications on the records. 

 

Add a Communication to a Client Record 

 

You can add general communications to a client record and categorise them by 

communication type.  You can also create letters and print them for posting or send 

them be email using Mail Merge (see later section).  

 

To add a general communication to a client record, locate and open a client in the client 

grid, right click the grey area of the tab, the following screen is presented: 

 

 
 

To log your communication, first select whether the communication is in or out of your 

office.  The means of communication can be changed by selecting and option from the 
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drop down list; you will find some of the options in the screen are dependent upon 

communication type. 

 

Enter a subject type, a job reference (if applicable) and a subject.  For example, the 

subject type might be Investigations, the subject might be VAT investigation 2012. 

The date will default to today’s date, which can be changed. The priority and status can 

be selected from drop down lists.  

 

Type your communication memo in the white space; this will be some detail on what the 

communication was about.  You can attach a document by clicking the Add attachment 

button, navigate to the document location, select the file and click Open. 

 

Click Save to save the communication memo on the client record. 

 

You can also add a communication memo to a client record by clicking the Add new 

communication button on the minor toolbar above the navigation pane: 

 
 

Using this method, you will need to select the client record and the type of 

communication. 

 

Communications can be seen either in the client record / Communications tab, or by 

clicking Communications on the main navigation pane.  From here, communications can 

be sorted, for example by priority, by client or communication type.  Closed 

communications will not appear in this grid. 

 

To record a general letter sent to or received from a client (without using mail merge) 

add a communication memo and select Letter as the communication type.  Fill in the 

fields as per the instructions above and then use Add attachment to attach a copy of the 

letter to the memo. 

 

Email Communication 

 

You can send an email on a client by client basis, or you can send an email to a range of 

clients, here we shall look at how to go about sending an email to a single client. 
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Open a new communication by either selecting the client from the main Client grid, right 

click in the Communications tab and select Add communication, or by clicking Add new 

communication on the top of the navigation pane.  Select Out as the direction of the 

communication and select Email from the communication type list.  Click the blue Email 

button to the right of the field, if the client record contains an email address it will be 

displayed in the To field, if there is no email address you can type it into the To field or 

click the Search button to the right of the field to search and select the address from 

your list of contacts stored in Outlook.   

 

Enter a subject in the Subject field.  If you need to attach a file click the paperclip attach 

button and click the add button to browse to the location of the attachment, click Save 

to attach the file.  The location of the attachment will appear in the attachment field in 

your email. 

 

Enter the detail of the email in the main email notepad.  Click Send.  Once the email has 

been successfully sent, the details will be copied to the main communication notepad. 

 

Mail Merge:  Create Letters, Send Emails to Clients 

 

Mail merge allows you to merge client data into documents, which can be printed and 
posted or emailed to clients.  Mail merge creates a communication record on each client 
record included in the merge.  Please note that there is a limit of 20 client records that 
can be included in an email merge; this is to prevent you unwittingly being blacklisted as 
a spammer.  

You create and maintain document templates using Document templates (see section 
above); these documents can then be used in the mail merge function. 

Click Mail Merge on the navigation pane, proceed as follows: 

1. If you want to use a document template in your mail merge click the templates 
button and select the document to be used (you can also add new documents and 
maintain existing ones from here).  You can use mail merge without a document, 
for example, if you just want to email a group of clients. 

2. Select the client/group of clients to include in the merge by clicking the Zoom 
button.  

3. Select the communication type; Letter or Email.  
4. Fill in the additional header details. If the communication is an email, select a 

signature. 
5. If the communication is an email type your email in the white space.  Your 

signature will be automatically added to the bottom of the text; press enter and 
leave an additional line at the bottom to come before the signature.  If the 
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communication is a letter, use the white space to enter a note on what the 
communication is about. 

6. To send an email communication without a document attachment, click Send 
email.  If you have attached a document, click Merge and send.  If you are 
producing a letter only, click start Merge. 

7. If the communication is a letter (to be printed and posted), click Merge; the 
document will be opened for printing.  A communication memo is added to the 
client(s) record. 

 

Receiving Client Emails 

 

Client emails received in your Outlook Inbox can be automatically directed to the client 
record in Client Manager, usually without intervention.   

The Microsoft Outlook Add-in for Client Manager matches incoming email addresses with 
those stored in client records in Client Manager, and routes them to the client record as 
communication memos.  The emails will not leave your inbox, but they will also appear 
as communication memos on your client records. 

The routing process is triggered by the receipt of an email in your Outlook inbox; any 
emails received prior to the add-on module being installed can be manually routed: 

• Right click the email in your inbox (click the envelop header, without opening the 
email). 

• Click Client Manager / Copy to communications from the pop up menu. 
• If the email address doesn’t exist within any of the client records in Client 

Manager, you will receive a message to that effect and the email will not be 
routed. 

There may be instances where an email is routed to more than one client record.  This 
will happen where an email address appears in more than one record, for example a 
shared email address between a husband and wife where each has their own record in 
Client Manager.  In this case, the email will appear on both records where it has been 
automatically routed by the system.  If you manually route an email and the address 
appears in more than one record, you will receive a message that this is the case and a 
prompt to select the record.  

 

Attaching Documents/Working Papers to a Client Record 

 

You can attach copies of documents or files to the client record in Client Manager; any 

mail merge documents you generate in Client Manager will be automatically attached to 

the client record as a communication memo.   
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When you assign jobs to a client that link to the various Keytime modules, you will 

notice the Docs tab in the client record is sub divided into a tab per job, this acts as a 

filing mechanism on the account, enabling you to easily locate a document or file by job 

type. 

 

You can add any type of file – Word documents, Excel spreadsheets, PDF etc.  In 

addition, any PDF documents that have been generated in any of the Keytime modules 

will attach themselves to the client record in Client Manager. 

 

To manually attach a document/file to a client record: 

1. Locate and open the client record in the Clients grid, click the Docs tab. 

2. Click the Add Document button and browse to the location of the document, click 

the file or document and click Save. 

3. Enter a brief description of the file contents (to aid identification later) and choose 

a job tab to store the document. 

4. To open an attached document, double click the document in the relevant tab. 

5. You can change how the attached documents appear in the Docs tab by clicking 

the Views buttons in the top right of each of the documents tabs. 

6. To remove a document link from a client record, click once on the document and 

click the Remove Document button. 

 

Adding Tasks to Client Records 

 

You can add events such as meeting reminders to client records by creating and adding 

tasks.   

 

To add a task to a client record, proceed as follows: 

 

1. Click the client record in the Client grid and click the Task tab, right click 

anywhere in the tab and select Add Task, alternatively, click Add Task on the 

minor toolbar and then select the client you want to add the task to. 

2. Enter a task due date, select a task type:  Event, meeting, task. 

3. Enter a description and assign the task to a member of staff. 

4. A task can be a one off event or can be a reoccurring event, if you choose 

reoccurring select the interval from the drop down list. 

5. Click Save and the task(s) will be added to the client record and will be visible in 

the Tasks tab and Tasks grid. 
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Assigning Tasks to Groups of Clients 

 

You can add general tasks to groups of client records; these tasks will appear in the 

Tasks tab of the client record and also in the main Tasks grid.  

1. Click Tasks in the Data group on the navigation pane 

2. Enter a task due date, select a task type:  Event, meeting, task. 

3. Enter a description and assign the task to a member of staff. 

4. A task can be a one off event or can be a reoccurring event, if you choose 

reoccurring select the interval from the drop down list. 

5. Click Save and the task(s) will be added to the client record and will be visible in 

the Tasks tab and Tasks grid. 

6. Click the data selection button to assign the task to a group of clients, use the 

search and filtering options to create your record group. 

7. Click select and the task will be added to the selected records. 

 

Working in the Tasks Grid 

 

The main Tasks grid filters and displays jobs/job stages and tasks for all or a range of 

clients.  You can range on job stages or tasks and by date, you can group jobs by job 

type, due date or client. 

• Select clients to view by clicking the search button by the Client field, search and 

select your client range.  Click Select. 

• In the Filters frame, select either Job stages or Tasks, select the staff member or 

all staff and select the client record status.  If you are viewing job stages group 

by job, due date or client. 

• Select a time frame, or enter your own custom date range. 

• If you are viewing jobs, click expand all to show an expanded view to job stage 

level, left un-ticked jobs will be presented, at job level. 

• Click Update to return the jobs or tasks to the grid. 

• You can expand or collapse jobs by ticking/un-ticking Expand all. 

• At job stage or task level, you can mark a job stage or task as complete by 

clicking the Complete box. 

 



40 | P a g e  
 

 
0845 456 3103 support.keytime.co.uk 

Maintaining Timesheets 
 

Timesheet Settings 

 

Setup some preferences before you start to process timesheets.  Click the Tools menu, 

select Timesheet Preferences, you can: 

 

• Create standard line descriptions; these are created and saved on a user basis, 

you create descriptions for the user you are currently logged in as.  Type your 

description in the Timesheet Description field and click Save: 

 

 
 

• Create activity codes for non-chargeable time; these are created once and are 

available to all users.  Click the Non-chargeable Descriptions tab, enter a code 

for the activity, enter a description and click Save: 
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• Time is generally entered as the total time spent, but you can optionally record 

the start and end time on a job.  To include the relevant fields click the Columns 

tab and tick the option include start time and end time. 

• Create disbursement items to include in timesheets; these are available for all 

users.  Click the Disbursements tab and enter a code and a description, click 

Save: 

 

• Once you are finished with your timesheet preferences click Close. 

Timesheets are entered on a weekly basis per staff member.  Click Timesheets in the 

Client Manager group on the navigation pane.  The fields across the top of the timesheet 

are for viewing and filtering existing timesheet entries, you can: 

 

• Select a client, or range of clients 

• View by staff member or all staff 

• Select a time frame or date range 

• Timesheets are entered per staff member/user 

• A WIP report can be generated from timesheet entries either at timesheet level 

showing all WIP for the user or at client level by right clicking in the Time & Fees 

tab of the client record.  
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Timesheet Entries 

 

Click Timesheets in the navigation pane 

In timesheets you can: 

• Create timesheet entries for chargeable and non-chargeable time; non-

chargeable time cannot be recorded against a client, you record this against a 

non-chargeable activity code. 

• Record disbursements against a client record.  

• Print a timesheet report – change the filters and options in the top of the 

timesheet screen to change the report criteria. 

• Pass/un-pass all timesheet entries 

 

Timesheet Filters 

 

You can filter timesheet entries by changing the options in the top of the timesheet 

screen: 

 

 
 

• To select timesheet entries by client(s) use the search and select options in the 

Search Clients frame. 

• To show timesheet entries based on date use the options in the Select Time 

Period frame, click Update to update the view. 

• To show timesheet entries for a member of staff, choose the staff member from 

the drop down list in the Staff frame. 

Recording Chargeable Time 

 

To add a timesheet entry, click Add Timesheet Entry on the minor toolbar above the 

navigation pane: 
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• Enter the client reference, or click the search button and select the client. 

• Press enter to move through the fields, the drop down Type field will behave 

differently depending on whether the time is chargeable or not, in this case the 

options are C or D (C is chargeable time, D is disbursement), select C, press 

Enter. 

• In the Job field select a job from the drop down list of jobs assigned to the client.  

If the client has a fixed price for this job a tick will appear in the Fixed price field; 

this cannot be removed at timesheet stage (it is controlled at client level)  

• Enter a description of the work carried out. 

• The staff member will default to the user currently logged in, but can be changed 

by clicking the drop down in the staff field and selecting a member of staff. 

• The date will default to the system date on the PC, this can be changed. 

• Enter total time spent on this job in the total time field, press enter and the 

number of units will be calculated and displayed in the Units field (this comes 

from the timesheet unit settings in the user profile). 

• The amount will either be calculated as number of units multiplied by rate per 

unit (this comes from the grade assigned in the user profile), or a fixed price if 

this applies to the client and job. 

• To pass a timesheet entry for billing, click the Pass box on the timesheet line; this 

will make the entry available to the billing wizard. 

• Pressing Enter on the end of each timesheet line will generate a new line in the 

timesheet; there is no need to click Add timesheet entry at each line. 

• Any of the timesheet entries can be amended as long as they have not yet been 

passed for billing.  To amend a timesheet entry, locate the line and double click it 

and make your changes. 
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Recording Disbursements 

 

• Enter the client reference, or click the search button and select the client. 

• Press enter to move through the fields, the drop down Type field will behave 

differently depending on whether the time is chargeable or not, in this case the 

options are C or D (C is chargeable time, D is disbursement), select D, press 

Enter. 

• From the drop down in the Code fields, select a disbursement code (for details on 

how to set up disbursement codes see section Timesheet Settings). 

• Press Enter and the description of the disbursement will appear in the Description 

field; this can be overtyped if you wish. 

• The staff member will default to the user currently logged in, but can be changed 

by clicking the drop down in the staff field and selecting a member of staff. 

• The date will default to the system date on the PC, this can be changed. 

• No time is recorded against a disbursement; as you press Enter you will be taken 

directly to the Amount column – enter the disbursement amount. 

• To pass a timesheet entry for billing, click the Pass box on the timesheet line; this 

will make the entry available to the billing wizard. 

• Pressing Enter on the end of each timesheet line will generate a new line in the 

timesheet; there is no need to click Add timesheet entry at each line. 

• Any of the timesheet entries can be amended as long as they have not yet been 

passed for billing.  To amend a timesheet entry, locate the line and double click it 

and make your changes. 

 

Recording Non-chargeable Time 

 

• Non-chargeable time cannot be recorded against a client record; you record such 

time against a non-chargeable activity (for details on how to set up non-

chargeable activities see section Timesheet Settings). 

• In the timesheet line leave the client ID and name field blank (press Enter 

through the 2 fields). 

• The Type field will change to N (non-chargeable), this cannot be changed as you 

cannot record chargeable time without a client record. 

• From the drop down list in the Code field select a non-chargeable activity. 

• As you press Enter the description of the non-chargeable activity will appear in 

the Description field, you can overtype the description if you wish. 
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• The staff member will default to the user currently logged in, but can be changed 

by clicking the drop down in the staff field and selecting a member of staff. 

• The date will default to the system date on the PC, this can be changed. 

• Enter total time spent on this job in the total time field, press enter and the 

number of units will be calculated and displayed in the Units field (this comes 

from the timesheet unit settings in the user profile). 

 

Timesheet Billing 
 

Setup Next Invoice Number 

 

Setup what will be your first bill number; the system will use and increment this number 

each time a bill is raised. 

Click the Tools menu, select Invoice Preferences, and enter your next number in the box.  

Once billing has begun this number cannot be changed. 

 

Generate a WIP/Billing Decisions Report 

 

Before you commence billing, you may want to generate a WIP report; this report shows 

a breakdown of outstanding WIP on a client or range of clients.  Disbursements and 

interim bills are also included and affect the overall amounts outstanding. 

To generate a WIP report click Print on the navigation pane, click the WIP tab.  Select 

Client WIP/Billing Decisions to show a breakdown of WIP (WIP Summary shows total WIP 

per client record). Choose a staff member or all staff, click the zoom icon by the Client 

ID field and select either a single client, range of clients or all clients, click Preview to 

view the report on screen (you can print from the screen), or click the down arrow and 

select an output option. 

The WIP/Billing Decisions report will show all outstanding billable items for each client; 

passed and un-passed timesheet entries, disbursements and any interim invoices with a 

total to be billed. 
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Start a Billing Session 

 

Click Timesheet Billing in the navigation pane. 

Timesheet Billing takes timesheet entries that have been passed and generates a billing 

report; you can then use the report to capture invoices in your bookkeeping system.   

In Timesheet Billing you can: 

 

• Select a client and produce an interim (on account) or a final (WIP) bill. 

• Combine WIP from a number of clients into one bill. 

• Suspend billing sessions (close and resume a billing session without clearing 

invoices in that session). 

 

Create an Interim (on-account) Bill 

 

Interim bills do not allocate any WIP; they are ‘on-account’ bills used to invoice the client 

in advance.  Interim bills appear in the client WIP report and reduce the overall amount 

of outstanding WIP.  Interim bills are cleared from the client account when you post a 

final bill and allocate the WIP. 

NOTE:  Overall profit (or loss) on a job is calculated as final invoice value plus any 

outstanding interim bills minus WIP allocated on final invoice.  Interim bills are recorded 

with neither a profit nor loss. 

Open a billing session and proceed as follows: 

1. Enter the client reference (or click the zoom icon and select the record), press 

Enter. 

2. You will be presented with options to create either and interim or final bill, select 

Interim and click OK. 

3. Enter the bill total and press Enter. 

4. Enter any narrative (this appears in the Narrative field in the invoice listing 

report). 

5. Press Confirm to finalise the bill. 

6. The details will appear in the bill session and at this point you can select and view 

a billing session report from the Billing Session Reports frame. 
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Create a Final (WIP) Bill 

 

Final bills allocate WIP and also clear any interim bills on the client record.  It is 

important to note that the system calculates any profit or loss on bills as interim bill(s) + 

final bill – WIP allocated.   

1. Open a billing session, select a client. 

2. You will be presented with a message to create either a final bill or an interim bill 

(the default is final), click OK. 

3. You normally allocate WIP to a final invoice, if there is no WIP present for this 

client you will see a warning message, but you will be allowed to continue. 

4. Enter the bill total and click Next. 

5. In the Details tab you will see passed WIP available for billing, click the WIP items 

you want to allocate to this bill, any that you don’t want to bill will be carried 

forward to the next bill for this client. 

6. You can add WIP from other client records, this may be a related record (via 

Associated Links) or not.  Click WIP. 

7. Enter the client ID or click Search and select the record, a list of passed WIP will 

be presented, select the WIP items to add to this bill, click Select. 

8. You can remove or add any item of WIP (WIP removed will remain outstanding on 

the client WIP report). 

9. Click Confirm; a message is presented giving you the option to proceed or cancel, 

click Yes to finalise the bill. 

10. The details will appear in the bill session and at this point you can select and view 

a billing session report from the Billing Session Reports frame. 

 

Finalise or Suspend a Billing Session 

 

You open a billing session and add bills to client records, you can report on these bills in 

any of the Billing Session Reports.  Once you clear a billing session you can still run 

billing reports, but you cannot report on individual billing sessions; the reports are 

generated based on date range, client the bills in a particular session are only available 

for as long as the session remains open. 

You can exit the billing screen, for example to view data in a client record or elsewhere 

in the system without clearing down the billing session by clicking Suspend and Close 
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in the top right of the billing screen. Click the Finish button on the top right of the billing 

screen to clear the billing session. 

 

Running Reports and Generating Client Lists from Queries 

 

Client Manager has a number of reports available, to access reports click the Print option 

in the navigation pane.  You can: 

• Print client listings, in summary or detail or group clients and report by job. 

• Print communication reports, in summary or detail. 

• Print timesheet reports, showing chargeable and non chargeable items. 

• Print WIP reports, in summary or detail. 

• Print summary invoice listings in client or bill number order, or a final invoice 

buildup report, which details final invoices and adds any interim bills to show a 

profit/loss. 

• All reports can be output to screen (you can print from the screen), printer, 

Excel, Word or PDF. 

In addition to client reports, you can query client records and create your own lists; 

these can then be exported to Excel.  Proceed as follows: 

1. Click Groups in the navigation pane. 

2. You can sort and filter client records using any of the tabs and options in this 

screen.  In addition you can create your own query by clicking the Search tab. 

3. Click Add and double click in the Fields box, select a database field to begin your 

query. 

4. Click in the Conditions field and select a condition from the list, some database 

fields will only attract one condition, for example database field Entity Type has a 

condition of Contains. 

5. Click in the Values field.  This field will behave differently according what is 

selected in the Conditions field, for example if you have selected Is Equal to the 

Values field will expect you to enter an absolute value. 

6. In the Operator field you can add further conditions by selecting And / Or 

7. To run the query click Search, Client Manager will return a list of records that 

meet your search criteria.  You can output the results to Excel by clicking Export.  

Select the fields you want to export from your query. 
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Backing up and Restoring Data 

 

Important note:  The backup and restore data options within Client Manager 

will backup or restore Client Manager data only; data held within the Keytime 

modules must be backed up or restored in the module.  See the user manuals or 

help files for the individual modules for instructions on how to do this. 

To backup Client Manager data, first ensure that all other users are logged out of the 

system, click the File menu, select Backup, choose a backup option: the client database 

or the letter templates folder (you may wish to consider backing up the letters folder 

from time to time), navigate to a suitable location to store your backup and click Save. 

To restore data, first ensure that all other users are logged out of the system, click the 

File menu, select Restore, choose a restore option (client database or letter templates 

folder), navigate to the location of the backup to be restored and click Save. 
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